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SUMMARY

This protocol describes how to culture, image, and determine the nuclear posi-
tion of a fluorescently tagged DNA locus in the 3D nucleoplasm of fixed Saccha-
romyces cerevisiae cells. Here, we propose a manual scoring method based on
widefield images and an automated method based on 3D-SIM images. Yeast cul-
ture conditions have to be followed meticulously to get the best biological
response in a given environment.

For complete details on the use and execution of this protocol, please refer to
Forey et al. (2020).

BEFORE YOU BEGIN

This protocol is for fixed-cell imaging and determination of the nuclear position of a fluorescently
tagged DNA locus in the 3D volume of budding yeast nuclei. Several loci change localization in
response to environmental cues. Relocalization of a given locus to the nuclear periphery is one of
the best described changes of localization in yeast. For instance, several highly transcribed genes
(constitutive or inducible) associate to the nuclear pore to promote optimal expression. Movement
to the nuclear periphery was also described for damaged replication forks and persistent double
strand breaks (DSBs), to promote DNA repair.

Several fluorescent systems have been developed to visualize a DNA locus in the nuclear volume in
yeast. The most efficient strategy to identify the boundaries of the nucleus is to express a fluores-
cently-tagged protein component of the nuclear periphery. Widely used and validated markers of
the nuclear periphery include Nup49-eGFP (Belgareh and Doye, 1997), Ndc1-Tomato (Dultz
et al., 2016), ERO4-mCherry (Randise-Hinchliff et al., 2016). Alternatively, one can identify the nu-
cleus volume using a fluorescently tagged nucleoplasmic protein with homogeneous distribution
such as Pus1-mCherry (Han et al., 2008). An endogenous locus is tagged by integrating in its imme-
diate vicinity an array of bacterial LacO or TetO DNA repeats (usually n=256, 10kb) that are bound by
respectively Lacl or TetR repressors fused to a fluorescent protein (e.g., eGFP or mCherry). Signal
intensity of the fluorescent spot depends both on the number of bacterial DNA repeats and the
expression level of the fluorescent bacterial repressor. Detailed description on how to build strains
can be found here (Hediger et al., 2004; Meister et al., 2010). Alternatively, strains can be made by
crossing pre-existing strains. In this case, bacterial DNA repeats are unstable without expression of
Lacl or TetR bacterial repressors. Score and select spores/transformants with the brightest spot.
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Here, we describe methods to culture and fix yeast cells, to image and process images, as well as
manual and automated methods to determine the localization of transcribed or damaged loci in
the 3D nucleoplasm.

Preparing a liquid carbon source (sugars)
O® Timing: [approximately 20 min]

Yeast growth requires a carbon source, which is generally D-glucose. D-glucose can be replaced
by other carbon source according to the experimental design (e.g., D-raffinose, D-galactose,
D-sucrose). We advise to prepare a sterile-filtered 20% carbon source.

1. For 20% of the desired sugar solution, in a 1L beaker, add
a. 750 mL of Milli-Q water, start agitating
b. Progressively add 200g of the desired sugar
c. Mix until the sugar is totally dissolved
d. Add waterto 1L
2. Sterilize by filtration on a 0.2 um 1-L filtration unit
3. You can store the liquid carbon sources at room temperature (20°C-25°C) for weeks.

Note: D-Raffinose generally takes longer to dissolve in water than other carbon sources. It is
possible to accelerate its dissolution by warming up to 40°C. Depending on the batch of raffi-
nose, the 20% solution can acquire a very faint yellow stain that do not alter its usage by yeast.

Preparing synthetic complete (SC) medium
O® Timing: [approximately 20 min]

For yeast imaging, synthetic complete (SC) medium is preferred over yeast adenine peptone (YAP)
medium in order to limit auto-fluorescence during image acquisition but YAP can be used. Steriliza-
tion is done by filtration instead of autoclaving.

4. For SC medium, in a 1 L sterile bottle, add
a. 279 of Dropout Base Medium (DOB) powder
b. 2g of SC Amino Acid mixture (Hopkins mixture) powder
c. Water up to 0.9L
5. Sterilize by filtration using a 0.2 um, 1L filtration unit
6. Store SC growth medium at room temperature (20°C-25°C) in the dark. SC medium is stable for
months without the carbon source.
7. Before use, add the appropriate carbon source to a final concentration of 2%

Preparing yeast adenine peptone (YAP) medium
O® Timing: [approximately 20 min]

8. For YAP medium, in a 1 L sterile bottle, add
a. 10g of Yeast Extract powder
b. 20 g of Bacto Peptone
c. 50 mg of adenine
d. Waterupto 0.9 L
9. Mix until complete dissolution of powders
10. Sterilize by filtration on a 0.2 um 1 L filtration unit
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11. Store YAP growth medium, at room temperature (20°C-25°C). YAP medium is stable for months
without the carbon source.
12. Before use, add the appropriate carbon source to a final concentration of 2%

Note: We recommend supplementing liquid medium with additional adenine. Several yeast
strains have mutations in the adenine biosynthesis pathway. Without adenine in the medium,
yeast strains might accumulate a red precursor during growth, leading to increased levels of
unwanted autofluorescence during imaging.

Preparing concanavalin-A-coated glass coverslips for yeast cell adhesion
O® Timing: [approximately 1 h]

13. Dissolve concanavalin A at 1% in PBS to prepare a stock solution

a. Prepare 0.5 mL aliquots

b. Store at —20°C for several years.
14. Dilute concanavalin A stock solution to Tmg/mL in PBS or sterile water
15. Pipet 50 pL of the solution onto a #1.5H (0.17mm) coverslip

A CRITICAL: Use the appropriate coverslip thickness. Most microscope objectives are de-
signed for 170um-thick borosilicate cover glasses. Moreover, coating the microscope
slide, rather than the coverslip, will result in spherical aberration. Indeed, even if the
mounting medium refractive index more or less matches the objective immersion medium,
this is still imperfect. The dozens of micrometers-thick mounting medium layer separating
the cover glass and the sample will induce aberrations and, therefore, reduce image qual-
ity. This problem will be even more apparent if super-resolution imaging is used.

16. Remove liquid

17. Air dry for 20-30 min

18. Concanavalin-A coated coverslips can be stored at room temperature (20°C-25°C) for several
months in a closed box.

Preparing exponentially growing cells
O® Timing: [approximately 5 min/step]

19. At least 2 days before the experiment, streak out yeast from glycerol stock (-80°C) on rich
glucose medium plates and incubate at 25°C-30°C.

20. Onthe morning before the day of the experiment, prepare a pre-culture by inoculating cells from
YPD plates in 5 mL liquid medium (SC or YAP supplemented with the desired carbon source) ina
50 mL aerated and sterile conical tube. Grow at 25°C with shaking (180-220 RPM) for 6-8 h.

21. On the evening before the day of the experiment, inoculate the appropriate volume of yeast
pre-cultures to reach 3-5.10° cells/mL the day after in 3-8 mL of liquid medium (SC or YAP sup-
plemented with the desired carbon source) in a 50 mL aerated and sterile conical tube.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER
Chemicals, peptides, and recombinant proteins

Glucose VWR Cat#R101175P
Galactose Sigma Cat#G0750
Raffinose Sigma Cat#R0250

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER
Dropout Base Medium (DOB) MP Biomedicals Cat#114025012-CF
SC Amino Acid Mixture (Hopkins mixture) MP Biomedicals Cat#114400022
Yeast extract powder Sigma Cat#Y1625

Bacto Peptone BD Biosciences Cat#211677
Bacto Agar BD Biosciences Cat#214010
Adenine Sigma Cat#A8626-100G
a-factor Biotem alpha-factor
Hydroxyurea Sigma Cat#H8627
Methyl methanesulfonate Sigma Cat#129925

H,O sterile Sigma Cat#W3500
Phosphate buffered saline (PBS) 10x Sigma Cat#P7059-1L
Concanavalin A Sigma Cat# L7647-25MG

Paraformaldehyde 16%

VWR/Alfa Aesar

Cat# 43368.9M

Software and algorithms

Huygens Professional
Image J/Fiji

PointPicker plugin for Fiji
Imaris

Scientific Volume Imaging
https://bioviz.org/
Philippe Thévenaz

Oxford Instruments

https://svi.nl/Huygens-Professional
https://fiji.sc/
http://bigwww.epfl.ch/thevenaz/pointpicker/
https://imaris.oxinst.com/

Other

50 mL Conical tube with filter cap CELLSTAR CELLreactor
Grace Bio-Labs SecureSeal

Microscope cover glasses 1.5H 18x18 mm

Microscope slides SuperFrost Menzel Gléaser
Microscope

Objective lens alpha Plan-Apochromat 1.46 oil DIC M27
High sensitivity camera sSCMOS ORCA-Flash 4.0 LT+
Fluorescence excitation light source (widefield)
Excitation and emission filters (eGFP)

Excitation and emission filters (mCherry)

Motorized XY stage

Structured illumination microscope

SIM objective lens 100x UPSLAPO oil PSF
Fluorescence excitation lasers (SIM) 488 nm
Fluorescence excitation lasers (SIM) 561 nm

Highly sensitive back-thinned EMCCD cameras (SIM)
Motorized stage motors (SIM)

High speed and accurate piezoelectric objective motor
TetraSpeck 1.0 pm microspheres

TetraSpeck 4.0 pm microspheres

TetraSpeck 0.2 pm microspheres

Shaking incubator

CASY cell counter

Greiner Bio-One

Sigma

Zeiss

Thermo Scientific

Zeiss

Zeiss

Hamamatsu

Excelitas

Zeiss

Zeiss

Marzhauser

GE Healthcare/Cytiva
Olympus

Coherent

Coherent

Teledyne Photometrics
GE Healthcare
Piezosystem Jena
Thermo Fischer Scientific
Thermo Fischer Scientific
Thermo Fischer Scientific
Infors HT

OMNI Life Science

Cat#227245
Cat#GBL654006-100EA
Cat#019030091
Cat#AG0O0008032E01FST20

Axio Imager Z2

Cat#420792-9800

Cat# C11440-42U30

X-Cite 120 LED

BP 470/40, FT 495, Em. BP 525/50
FS45 Carl Zeiss Ex. BP 560/40, FT 585 Em. BP 630/75
SCAN 130*85 DC Tmm

OMX-V4 or OMX-SR

Cat# N90027818
Catt#sapphire488-200/1099487
Cat#Sapphire 561-200 CW 1168049
Evolve 512B

Cat#52-506191-002 and Cat#52-506191-003
NV40/1 CLE

#17282

#77283

#T77280

Minitron

CASY cell counter and analyzer

MATERIALS AND EQUIPMENT

v Incubator with temperature (23°C-30°C) and humidity control (for yeast plates)
v Shaking incubator (150-220 RPM) with temperature control (23°C-30°C) (for liquid cultures)

(e.g., Infors HT, Minitron)

1 Spectrophotometer (ODgqg) or cell counter (e.g., CASY from OMNI Life Science) to measure

cell concentration in liquid cultures.

1 Widefield microscope with the following equipment (see key resource table):

e A high numerical aperture (NA) 100x magnification immersion objective is recommended
(e.g., >1.3). The sample mounting medium’s refractive index should match the
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objective’s immersion medium to avoid deformation along the axis or unwanted spherical
aberrations.

e We recommend using non-curing mounting medium, as 3D sample deformation (i.e.,
compression in the axial direction) might occur as medium hardens.

e LED or laser fluorescence excitation light source.

e Selective band-pass fluorescence filter sets

e Ahigh sensitivity (high QE, low noise) camera. Ideally, sCMOS camera with a wide detector
should be used to acquire a large field of view. sSCMOS technology allows parallel reading of
the pixel array, so that the field size is increased while the readout rate is kept reasonable.
The pixel size should fulfill the sampling density Shannon-Nyquist criterion. The resolution
limit of a microscope sets the minimal distance above which two separated spots can be de-
tected as separated. The voxel spatial dimensions (i.e., pixel size and Z step) should be
appropriate to discriminate these objects until they are separated by a distance smaller
than the resolution limit. During image digitalization, substantial information recorded by
the microscope can be lost. Information loss is a general sampling issue, i.e., occurs when-
ever a continuous signal (the real sample) has to be converted into a discrete digital signal
(voxels). The Shannon-Nyquist theorem states that the sampling distance (in our case the
voxel dimensions) should be greater than twice the band width of the input signal to allow
a faithful reconstruction of the original sample (Shannon, 1998). Larger dimensions will result
in information loss, as high frequencies are not captured in digitalized images, thus degrad-
ing the final resolution. There are different ways of handling this Shannon-Nyquist criterion.
An easy one is to have pixels and z-step sizes below 2.3 times the lateral and axial resolutions
distances respectively. A second, more accurate approach is to use equations describing
the process of sampling for each microscope type such as in (Gannaway, 1977; Sheppard,
1986; Wilson and Tan, 1993).

e A motorized XY stage for automated acquisition of multiple positions.

v 3D-Structured lllumination Microscope with the following equipment (see key resource table):

o An OMX-V4 or OMX-SR

e A high NA 100% objective

o A set of oils with a range of refractive indexes to correct for spherical aberrations

e High sensitivity back-thinned EMCCD cameras. The pixel size of the camera must be opti-
mized to fulfill the Shannon-Nyquist criterion. In our case the pixel size corresponds to
79 nm in the sample.

o Fluorescent excitation light sources appropriate for the fluorophores. In our case we use la-
sers emitting at 488nm for the eGFP and 561nm for the mCherry. Our system is equipped
with custom higher power lasers but they are not necessary.

e Emission filters that are adequate to fluorophores: 528/48 for the eGFP and 609/37 for the
mCherry. Other filter sets might be more suitable for these fluorophores.

Note: Other 3D-SIM microscopes may be used for this application, but have not been tested
here.

STEP-BY-STEP METHOD DETAILS

Culturing yeast cells to determine the nuclear position of a single DNA locus by imaging
O® Timing: [3 days]

1. Grow cells overnight at 25°C while shaking (180-220 RPM) in a 50 mL aerated and sterile conical
tube containing 3-8 mL of liquid medium (SC or YAP supplemented with the desired

carbon source) to reach a maximum concentration of 3-6.10° cells/mL (OD600 = 0.3-0.4) in
the morning.

STAR Protocols 2, 100525, June 18, 2021 5
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A CRITICAL: Cell concentration should not exceed 1,2.107 cells/mL (OD600=0.8) in SC medium
or 2,5.107 cells/mL (OD600=1.1) in YAP medium in order to maintain exponential growth and
avoid diauxic shift. If cell concentration is too high, dilute the culture to 1-2.10° cells/mL with
fresh medium and let cells grow for at least 4h before starting the experiment.

. For constitutively expressed loci (e.g., RPLA), cells growing exponentially in 2% glucose can be

directly used. See notes below for loci-specific cultures conditions.

. Monitoring replication origins position requires cell synchronization in G; and release into

S phase

a. Gj synchronization is obtained by adding 3 times 2,7 pg of alpha-factor (every hour) per mL to
a culture at 5.10° cells/mL at 25°C.

b. After 2h30in alpha-factor, divide the cell culture and add 100mM of hydroxyurea (HU) in half of
the initial culture to pre-treat cells with HU for 15 min before release. Keep the other half un-
treated to release cells from alpha-factor without genotoxic agents.

c. After 2h45 in alpha-factor, wash-out alpha-factor by filtration and transfer cells either into fresh
medium for 30 min (untreated culture,S phase condition) or into medium supplemented with
genotoxic drugs such as 0.2M hydroxyurea and 0.033% methylmethane sulfonate for 60 min
(HU pretreated culture, damaged condition).

d. We advise to regularly check the status of cells in the cell cycle under a regular optic micro-
scope. Cells synchronized in G exhibit a typical “shmoo” projection whereas cells in S phase
show a small bud.

A CRITICAL: For the damaged condition, add hydroxyurea in the culture medium at the end
of the G4 synchronization (at least 15 min prior to alpha-factor removal) and in the medium
where cells will be released into S phase. Adding hydroxyurea 15 min prior to alpha-factor
release allows the drug to completely dissolve in the medium and enter cells. Add methyl
methanesulfonate solution to cell culture right after washing-out alpha-factor. Alterna-
tively, unsynchronized exponentially growing cells can be directly treated with genotoxic
drugs for 1 or 2h. In this case, when analyzing microscopy images, the experimenter can
select S phase cells based on their morphology (i.e presence of a small bud).

Note: GALT-GAL10genes change nuclear localization in response to available carbon source.
Overnight growth in repressive 2% glucose medium results in an almost random positioning of
the GALT-GAL10 locus in the nuclear volume. Although the non-repressive raffinose medium
does not drive expression of GAL genes, overnight growth in 2% raffinose leads to a prefer-
ential positioning of the GALT-GAL10 locus to the nuclear periphery. Galactose-induced
expression of GAL genes is efficient in raffinose and leads to a very rapid and strong relocation
to the nuclear periphery. Optimum galactose induction occurs at low cell concentration (3.10%
cells/mL) and GALT-GAL10 relocation to the nuclear periphery can be easily scored after
90 min in 2% galactose (from cells grown in 2% raffinose) (See troubleshooting 1).

Note: Mating pheromone inducible genes (e.g., FIG2, PRM1 and FUS3) respond to alpha-fac-
tor when MATa cells are grown in 2% glucose. Optimum mating pheromone-induction occurs
when cells at 5.10° cells/mL are treated 3 times (every hour) with 2,7 ug of alpha-factor per mL
of culture at 25°C. Cells are fixed after 2.5 h in the presence of alpha-factor.

Fixing cells with paraformaldehyde

O® Timing: [10 mins]

4. At the time of interest, collect 1.5 mL of yeast culture (see previous step) and spin for 1 min at

10000 X g

5. Remove supernatant

6
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6. Resuspend cell pellet in 50 pL of 4% freshly prepared or freshly opened PFA vial and fix cells for
30-60 s

A CRITICAL: Longer PFA fixation will inactivate the fluorophore.

7. Spin immediately at 10 000 x gfor30's

8. Remove supernatant and wash with 500 pL of PBS

9. Repeat washes twice

10. Resuspend cell pellets in 100 to 300 pL of PBS (See troubleshooting 2)

Il Pause point: Fixed cells can be stored for several days in PBS at 4°C in the dark or used
directly for imaging.

Note: Using freshly made PFA or PFA freshly opened from a vial is critical to ensure reproduc-
ible and optimal fixation of samples. PFA can be prepared from 16% commercial stock vials
(e.g., Alfa Aesar) with water.

Preparing samples on concanavalin A coverslips
® Timing: [30 mins]

11. Pipet 40ul of fixed cells (see previous step) on a concanavalin A-coated coverslip
12. Incubate for 15-20 min at 20°C-25°C

13. Remove excess of yeast suspension

14. Wash cells by adding 50u! of PBS and removing the liquid.

15. Repeat wash step twice

16. Remove the liquid and add a few drops of mounting medium

17. Remove the white paper and stick a SecureSeal adhesive imaging spacer on glass slides
18. Peel the clear plastic from the adhesive imaging spacer

19. Stick the yeast-covered coverslip on the adhesive imaging spacer

20. Remove excess of mounting medium with a precision wipe

21. Cells are ready for imaging

10 Pause point: Mounted cells can be stored in the dark for a few hours.

Note: Although mounting could be done without imaging spacers, the advantage of imaging
spacers is to confine yeast cells without compression and to maintain constant humidity. The
mounting medium should be chosen appropriately. While PBS can be tolerated for widefield im-
aging when the object is close to the coverslip, a well matching refractive index mounting media is
an absolute requirement for super-resolution imaging. The best mounting medium will (i) preserve
fluorescent proteins (eGFP, mCherry) intact, (i) preserve the 3D shape of the sample and (iii) have a
refractive index that matches as much as possible the refractive index of the immersion medium
refractive index (e.g., non-curing and DAPI-free VECTASHIELD from Vector Labs). Be aware that
the performance of a given mounting medium depends on the fluorophore used.

Widefield image acquisition

O® Timing: [15-30 min/sample]
In this section, we describe the settings for experiments using an insertion of 256 copies of the LacO
sequence and fluorescently-tagged Lacl proteins which tightly bind to the LacO sequences. The

insertion of the LacO sequences near a locus of interest allows the visualization of this locus in the
nuclear volume. The outer limit of the nucleus is visualized either by the fusion of a fluorescent

STAR Protocols 2, 100525, June 18, 2021 7
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tag to a protein of the nuclear pore complex (e.g., Nup49) or by expressing a fluorescently-tagged

marker of the nucleoplasm (e.g., Pus1). The settings presented in this section can be used as a start-

ing point and might require optimization depending on the widefield microscope used.

22.
23.
24.
25.

26.

27.

8

A CRITICAL: If using different fluorophores (such as GFP and mCherry), ensure that the imaging
system'’s chromatic correction is within specifications using regular Quality Control procedures.
Indeed, due to the very nature of multi-wavelength light, microscopes are subject to chromatic
aberrations. Although adequately equipped modern microscopes are less subjected to chro-
matic aberrations, we advise their measures to avoid introducing a systematic error in our pro-
cedure. We do it on a regular basis (i.e every second week) using multi-labelled fluorescent
beads slides (such as 1 pm or 4 pm TetraSpeck beads, smaller beads sizes are not recommended
as their lower Signal/Background ratio will induce variability). We recommend a final bead con-
centration of 1bead/10pm? to ease the image acquisition process and still have enough beads
for analysis. Bead center for each channels are localized in 3D and the inter-center distances
should be below the reference resolution distance (i.e equivalent to the minimal resolution dis-
tance, taking into account the lowest emission wavelength) of a similar bead center couple (Mas-
calchi and Cordeliéres, 2019). The MetroloJ ImageJ plugin is suitable for this calibration.

Turn on the microscope, camera, fluorescence light source and open the microscopy softw
Focus on cells using transmitted light
Switch to 100x objective

are

Choose a field of view with a medium cell density (individualized cells; corresponds to 50-80

cells with our settings, Figure 1A)

A CRITICAL: If no field of view is appropriate, we advise adjusting cell concentration in PBS
and preparing new slides as indicated in “preparing imaging samples on concanavalin A
coverslips”. See troubleshooting 3
Switch to fluorescence excitation light and check signal emission for each fluorophore

A CRITICAL: If fluorescence signal is globally uneven or faint, consider using fresh PFA.

Moreover, fixation should not exceed 1 min including centrifugation. Fix again new cells

as described in “Fixing cells with paraformaldehyde”. See troubleshooting 2.

Set acquisition parameters in imaging software

a. Z-stacks, 50 slices of 0.2 um (the Z-step size should follow Shannon-Nyquist sampling density

criterion as described earlier). Determining the position of a DNA locus in the 3D nucleo-
plasm requires to cover the whole yeast nucleus. Yeast cells typically range from 4 to
10 um, thus this setting should cover the majority of cell’s nuclei in any field of view.

b. X and Y-Tiles, 5 fields of view can be imaged. Robust determination of a DNA locus nuclear

position is achieved by measuring its position in at least 200 individual cells. Although mea-
surement is done on individual cells, we recommend imaging cells from at least two indepen-
dent cultures/treatment to minimize single-culture bias and to ensure reproducibility of the
scored biological effect. Adjust the number of fields of view to be imaged according to the
cellular density of the sample and to pixel size.

. Excitation power and exposure time have to be adjusted according to the light source, the

sensitivity of the camera and the intensity of the signal on the imaging sample, as to both
have a high dynamic range, while leaving margin for potentially brighter samples, and
keep the fluorescence bleaching low. With a LED light source, we typically set the excitation
power to a high value (i.e., 100% for Excelitas X-Cite 120 LED which corresponds to a light
intensity of 6.85mW across the full field of view, as measured with a 10x 0.45 dry lens and
a OP2-VIS Coherent probe) with a typical exposure time of 200-500ms with an Hamamatsu
ORCA Flash4.0 LT sCMOS camera of a peak QE of 82%. Although the tagged locus exhibits a
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Figure 1. Determination of the 3D nuclear position of a tagged DNA locus from widefield microscope images using
the zoning assay

(A) Representative field of view of fixed cells during image acquisition (single Z plane). Cells express a marker of the
nuclear periphery (Ndc1-Tomato) and a marker (Lacl-eGFP) to track the locus of interest (RPLA).

(B) Screenshot of the Fiji/ImageJ toolbar.

(C) Screenshot of the Fiji/lmageJ toolbar with the PointPicker plugin active.

(D) Model of a nucleus segmented in three zones of equal area in 2D space which also segment the nucleus in three zones of
equal volume in 3D space (dash gray lines). Zone 1 corresponds to the most peripheral localization whereas zone 3 is central. Red
lines indicate the regions which are discarded from the counting at the top and the bottom of the nucleus.

(E—G) Zoom in on several cells from the sample field of view in (A). (F) Application of the zoning assay by defining the
three coordinates required: #1 center of the most proximal nuclear periphery region in front of the DNA-Lacl-eGFP
spot (NP1), #2 center of the DNA-Lacl-eGFP spot (spot), #3 center of the opposite nuclear periphery region in front of
the DNA-Lacl-eGFP spot (NP2).

(H) Screenshot of the log file containing the coordinates defined in (F).

stronger fluorescent signal in comparison to the nuclear periphery since it is bound by mul-
tiple fluorescent protein, the aim is to obtain images allowing to position both the nuclear
periphery and the tagged locus spot.

A CRITICAL: Set the best excitation/exposure time, and EM-gain if relevant (i.e., if using an
EMCCD instead of sCMOS camera), to limit bleaching and yield an optimal dynamic range.
As bleaching is the result of many parameters, start with above-indicated values and adjust
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illumination/intensity and exposure time. We typically obtain widefield images with a dynamic
range of 5,000 to 10,000 levels, which are further processed with deconvolution algorithms. If
needed, lower dynamic ranges may be used, with adapted corrections applied to take into ac-
count the lower signal/noise ratio. The experimenter should optimize the settings to obtain
good quality images so that foci/nuclear envelope can be both determined.
d. Set-up acquisition for each fluorophore in all z-stacks. Yeast outlines can be given using DIC
imaging (only acquire the single central plane, as Z information is not relevant).

28. Turn on transmission light and focus on the center of the cells
29. Choose 5 field of view/tiles and start automatic (or manual) acquisition. A motorized XYZ stage
with a mark option is convenient to acquire 5 Z-stacks in a single click.

Widefield image deconvolution using Huygens Professional
O® Timing: [10-20 min/image]

Deconvolution of microscopy images is a computational technique allowing to partly compensate for the
image distortion created by an optical system (McNally et al., 1999; Swedlow, 2013). This image resto-
ration process is used to improve image resolution, contrast and signal to noise. The change in focal
plane during the acquisition of z-series images (3D) generates slightly different images caused by out
of focus light coming from above and below the current z-plane. One can consider a biological object
as a sum of individual sub-resolution light sources. Because microscope-imaging systems collect only
a fraction of the light emitted by these sources, the acquired image appears as a sum of 3D blurry images
given by a single point source (aka. the Point Spread Function or PSF). The application of the PSF to every
point in the specimen to produce the final image is called a convolution. The restoration procedure of
deconvolution would go the opposite way, collecting all this spread light and putting it back to its original
location. This process attempts to reconstruct the specimen from a blurred image. Deconvolution largely
facilitates DNA-locus position scoring. The procedure and settings described here correspond to the
Huygens deconvolution software, but could be applied to other deconvolution programs.

30. Before the actual deconvolution process, remove background locally. We use a region of 0.7um with
the Huygens Professional background estimation algorithm, which identifies 3D regions with the
lowest intensity for background estimation. Any other satisfying background removal solution with
a different software may be used. The best deconvolution suites estimate and correct the images
for the noise (photon shot noise, set-up associated noise). The signal to noise ratio (SNR) of widefield
images acquired in the above-mentioned condition is approximately of 100.

Optional: If necessary, apply a bleaching correction to avoid an intensity bias as the first
imaged plane will be less affected than the last image of the 3D stack. However, using appro-
priate conditions of illumination/exposition duration, bleaching was negligible.

31. Perform deconvolution with a Maximum Likelihood Estimation (CMLE in Huygens) algorithm.
Set the maximum number of iterations to 40 and an iteration exit “quality threshold” value
(see note) of 0.1%. With this setting, iterations will stop before the maximum 40 value if no
more than 0.1% change of the quality value is observed between the last two iterations. This op-
timizes the restoration duration by stopping unnecessary iterations.

32. Ifusing a correction that takes into account noise, use a SNR value of 100 for sCMOS camera and
widefield setups (please note this is different from the signal to background ratio and this
parameter aims to correct for photon shot noise mainly). Adjust this value if using lower dynamic
ranges for instance or different setups.

Note: For the purpose of image deconvolution, we used theoretical PSFs. Deconvolution us-
ing measured PSF using the 100x alpha Plan-Apochromat 1.46 oil DIC objective and 160nm
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fluorescent beads did not yield any better result. If the deconvolution software package used
does not provide any computed PSF model, the user may use averaged 3D stacks of subreso-
lution fluorescent beads. If it does, consider comparing acquired PSF and computed ones. If
the objective quality is optimal, the tedious step of acquiring PSF images can be avoided.

Note: The Huygens software uses a quality criterion that evaluates the difference between the
acquired image and the iteration result. It uses a Csiszar's Information Divergence parameter.
We typically use a 0.1% change threshold (meaning the iterations stop if the difference be-
tween quality factor of iteration n and n+1 is less than 0.1% of quality factor n). This optimizes
the restoration time and stops unnecessary iterations. If the deconvolution package used has
no such optimization option, the user may try different iterations values and, comparing
different restorations results, choose the optimal iteration number. If different microscope
setups are used (such as spinning disc confocal microscope), this signal to noise ratio should
be reconsidered. Confocal images have a smaller SNR ratio.

3D structured illumination microscopy image acquisition

3D-SIM is a super-resolution technique that provides an 8-fold volumetric improvement in resolu-
tion. This super-resolution is achieved by mathematically recovering the information, in frequency
space, outside the observable region that is produced when the sample is excited by a known
3 dimensional structured pattern (Gustafsson et al., 2008).

For further information, a comprehensive view of good practices for 3D-SIM imaging has already
been described (Demmerle et al., 2017).

33. Switch on the microscope according to the manufacturer instructions
34. Configure the acquisition to be in “All channel then Z” mode and the focus point at start “Top”

Note: Choosing the top of the stack as the focus point is more reliable than the middle to ac-
quire the whole nucleus.

35. Place your sample and focus using the transmitted light. This is better than using fluorescence
for sample preservation and allows to find the focus from a much larger range

36. Optimize the spherical aberrations of the system using oils with different refractive indexes. For
example, we use an oil with R.I of 1,512.

37. Configure the acquisition setting in order to have the highest SNR and the lowest possible
photo-bleaching. To do so we have used high EMCCD gains and sacrificed some of the resolu-
tion by using relatively high wiener filtering during reconstruction. For a detailed 3D-SIM acqui-
sition, please refer to Demmerle et al. (2017). The following acquisition settings could serve as a
starting point prior to further optimization:

a. eGFP: 5 mW for laser excitation power (measured at the back focal plane of the objective and
achieved in our system with a 200mW Laser using a 10% ND filter), 15 ms as exposure time
using a Photometrics Evolve 512B camera, EMCCD gain and read frequency at 150 and 5SMhz
respectively. We obtain with these settings some 35k gray levels. We reconstruct with a
wiener filter at 0,02.

b. mCherry: 0.2 mW for laser excitation power (measured at the back focal plane of the objec-
tive and achieved in our system with a 100mW Laser using a 1% ND filter), 60 ms as exposure
time, EMCCD gain and read frequency at 200 and 5Mhz respectively. We obtain with these
settings some 13k gray levels. We reconstruct with a wiener filter at 0,01.

Optional: If allowed by your equipment, you may mark a certain number of positions and let
the microscope perform the acquisitions in an automated way. It is important to minimize
microscope displacements and to set a minimal stabilization time prior to acquisition of,
atleast, 1s.
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Figure 2. Determination of the 3D nuclear position of a tagged DNA locus from 3D-SIM images using absolute
distances obtained with the Imaris software

(A and D) (A) Representative S phase or S phase + DNA damage (D) nuclei obtained after 3D-SIM reconstruction in 2D
(single Z plane). Nucleoplasm is stained with Pus1-mCherry and ARS607 is tagged with LacO-Lacl-eGFP. Cells are
numbered.

(B and E) 3D-SIM reconstructed images visualized in Imaris. White arrow heads indicate duplicated fluorescent Lacl-
eGFP loci during S phase.

(C and F) Segmented nuclei obtained with the Imaris software as described in the protocol.

38. During 3D-SIM image reconstruction, use channel specific OTF's (Optical Transfer Function) and
channel specific wiener filters.

39. Verify reconstruction quality using Fiji (Figures 2A and 2D) and the SIMcheck plugin. If required
by your instrument, align channels.

Note: SIMcheck is a plugin for ImageJ to support in troubleshooting and providing Quality
Control metrics of the 3D-SIM reconstruction (Ball et al., 2015).

Chromatic aberration corrections

As 3D-SIM channels are acquired using different light paths/cameras, the very process of multicolor
image reconstruction takes the chromatic aberrations into account. This correction uses softWoRx,
the same software package used for reconstruction. Chromatic shifts are characterized using the
manufacturer’s alignment slide and procedure for the lateral alignment. We use 200 nm TetraSpeck
multi-labeled beads to correct for the axial shifts. Corrected images typically exhibit an error that is
below half the lateral resolution for x and y and below 70nm in z across the whole stack.

Manual scoring of a DNA locus position in a 3D nucleus using Fiji
O® Timing: [20 min/sample]

The principle of the zoning assay has been extensively described in Meister et al., 2010 (Methods in
enzymology, Guide to yeast genetics, chapter 21). In this assay, the nucleus is divided in 3 concentric
zones of equal volume and the DNA locus, visible as a fluorescent spot, is sorted into one of the three
zones. The firstzone is associated to the nuclear periphery whereas the third zone corresponds to the
center of the nucleus (see Quantification and statistical analysis for details). In this setup, a locus
whose position is random in the nucleus will have an equal probability of 33% to localize in each
of the three zones. Zoning assay requires the coordinates of the spot (fluorescently tagged locus),
the distance of the spot to the nuclear periphery (fluorescently tagged) and the diameter of the
cell nucleus. Several programs can be used to extract these parameters; we advise to use Fiji
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(ImageJ) with the freely available PointPicker plug-in. Widefield and 3D-SIM images are compatible
with this approach.

40. Download and install the PointPicker plug-in (http://bigwww.epfl.ch/thevenaz/pointpicker/) on Fiji
41. Open a deconvolved image in Fiji.

Optional: If the periphery and the spot images are stored in different files, open the
two images corresponding to each fluorophore and merge them in a single image. Select
Image -> Color -> Merge channels. Select and assigned either images to a color (e.g.,
Nup49-eGFP/periphery in green and Lacl-mCherry/spot in red). This will generate a compos-
ite image including both channels/colors (Figure 1A).

42. Adjust the brightness and contrast of the image. Select Image -> Adjust -> brightness/contrast.
In the B&C panel, select auto and optimize manually (Figure 1B).

43. Go to Plugins -> PointPicker. PointPicker options will now appear in the Fiji software (Figure 1C)

44. Navigate into Z-stacks and select nuclei which have a spot positioned between top and bottom
poles in order to score the DNA locus position (Figure 1D).

45. Once you have selected a nucleus, select the first icon “Add Crosses” and add the first cross in
the center of the nuclear periphery fluorescent signal which is closest to the DNA locus spot (X/
Ynp1). The second cross marks the fluorescent DNA locus spot center position (X/Yspot) and the
third cross is placed on the opposite side of the nuclear periphery (X/Ynp2) (Figures 1E and 1F).

A CRITICAL: Excluding nuclei which exhibit a tagged DNA locus at the bottom or the top of
nuclei poles is essential since these spots can’t be correctly assigned to a given zone (e.g.,
Cell 3 in Figures 1F and 1G).

46. Repeat nuclei selection (step 44) and coordinates labeling (step 45)

47. When you reach the appropriate number of scored nuclei (~200) or until all the nuclei on the
opened image have been scored, export the coordinates of the points by selecting the
"Export/Import list of points" icon on the PointPicker toolbar (Figure 1C). Choose the “show”
option.

48. Select and copy coordinates from the log file (Figure 1H) to a spreadsheets software (e.g., Mi-
crosoft Excel or OpenOffice)

49. A single nucleus is characterized by three coordinates (in X and Y) corresponding to the three
crosses made on the image.

a. Thefirstset of coordinates (X/Ynp1) is the position of the nuclear periphery which is closest to
the DNA locus

b. The second set of coordinates (X/Yspot) is the position of the DNA locus (fluorescent spot)

c. The last set of coordinates (X/Ynp2) is the position of the nuclear periphery on the opposite
side of the DNA locus spot

50. Calculate pore-spot distances (np = nuclear periphery ; spot = DNA locus):

(1) distance (NP — spot) = \/(Xspot — Xie)? + (Yopor — Yor)’

1. Calculate nucleus diameters:

(2) nuclear diameter = \/(XNP1 — XNP2)2 + (YNP1 — YNPZ)Z
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2. Normalize the pore-spot distance to the radius of the nucleus:

distance (NP — spot)
nuclear diameter

(3) p( = spot position) =

3. Sort nuclear spot in one of the three zones:
a. Zone 1ifp<1— /(2/3) (i.e; p<0.184)
b. Zone 2, if p between 1 — /(2/3) and 1 — /(1/3) (i.e; 0.184 <p <0.422 )
c. Zone 3,ifp>1— /(1/3) (i.e; p>0.422)

Automatic scoring of the 3D position of a DNA locus using Imaris
O® Timing: [20 min/sample]

Imaris (Bitplane/Oxford Instruments) is a commercial software allowing 3D reconstruction and cell
features measurement. We chose this software as it allows image analysis automation and involves
minimal user interaction. We combined it with Imaris-run Matlab routines (available on the Imaris
website). Other free 3D solutions can be used.

“Nuclear” envelopes are identified based on the Pus1-mCherry voxel intensities. Lacl-GFP voxel in-
tensity is used to determine the Lacl spot 3D coordinates in the nucleus. Then, the nearest distances
between these objects are computed using Euclidean distance maps. The distance map transforma-
tion process creates a novel “distance” channel. Each voxel intensity in this “distance channel” is
equal to its distance to the nearest surface edge/spot. The distance to the “nuclear envelope”, as
defined by the Pus1-mCherry signal, is computed with positive values inside the nucleus. Extracted
absolute distances can be used directly or applied in an emulated zoning assay. Although widefield
images allow for 3D reconstruction and 3D measurements of absolute distances, their lack of reso-
lution and high levels of chromatic aberrations do not guarantee an accurate positioning. Thus, this
approach is optimal with high resolution 3D-SIM images.

51. Open the Imaris software, select XT module to allow the use of Matlab routines.
52. Select Observe Folder and choose the reconstructed and aligned images (SIR.ALX) (Figure 2B
and E). Images are automatically converted in the .ims format.

A CRITICAL: Check that the microscope has been calibrated and that the voxel size corre-
sponds with images metadata (Edit>Image Properties and Geometry in Imaris), as this
is crucial to get appropriate distances.

53. Open one image and start nuclei segmentation:

a. Add new surface using the appropriate channel (e.g., Channel 1 for Pus1-mCherry). If
needed, calculation can be optimized using a smoothing factor that will reduce the number
of vertices used to draw the nuclear “envelope”.

b. Define an automatic intensity threshold value to identify nuclei based on their Pus1-mCherry
signal intensity (Figures 2C and 2F).

Optional: If not using background-free SIM images, first apply a background removal algo-

rithm if the nucleus segmentation is not adequate. Background Subtraction in Imaris applies
a Gaussian filter to estimate the background intensity value of each voxel. This variable
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background is then subtracted from every voxel in the image. This step is not necessary for
SIM images, given their very high contrast.

Alternatives: Some parameters are fixed (spot size, nucleus size) but some parameters
depend of your experiment (the intensity of fluorophores). Making sure segmentation param-
eters yield appropriate nucleus segmentation for different datasets is highly recommended. If
not using an automatic threshold, checking this is even more important. You may have to
manually adjust this parameter for different datasets.

A CRITICAL: Nuclei in close proximity could be fused during the segmentation process. If
this the case, discard doublets by applying a size filter based on the highest single nucleus
volume value typically observed in the dataset.

54. Identify the Lacl loci coordinates. These loci sizes are expected to be subresolution. Segment
Lacl spots signal by using the “add new spot” function and select the Lacl illumination channel
(e.g., Channel 2 for Lacl-eGFP). Any other spot finding solution (such as find extrema in Fiji) can
also be used. Using SIM images, all spots sizes should be close to the resolution limit. The sys-
tem'’s lateral and axial resolutions are typically 110 nm and 300 nm respectively (for 525nm emis-
sion wavelength). Thus an “average” value of 0.15um in all dimensions can be used as a starting
value (Figures 2B and 2E). Reconsider this value if some spots are not detected or if non-spot
features are identified. If using a different microscope setup, reconsider this value with respect
to the setup'’s resolution. This step only allows spots identification and has no incidence on the

actual spot distance measurements.

Note: The axial resolution of widefield microscopes is roughly two times lower than in the
lateral direction, leading to oblong-shaped spots. This can be corrected using the estimated
Z PSF size. Alternatively, aberrant spots can be filtered out using some spot-parameter
threshold such as total spot intensity/prominence (i.e., ratio of the intensity of the spot
compared to its immediate vicinity). We used an automatic quality threshold in Imaris.
Make sure this procedure is robust enough so that different datasets are correctly
segmented/filtered and only real loci are detected while none that should be found is lost
(i.e in haploid cells, a single-tagged locus should give a unique fluorescent spot).

Optional: The point of automatic measurement is to limit user-introduced bias and repetitive
unnecessary steps. For both surface and spots parameters, we saved them as “creation pa-
rameters templates” and used for batch segmentation of nuclei/Lacl loci of whole datasets.
Make sure nuclei surfaces are created before spots segmentation in the objects list, as this
will be important for the next step.

55. Control the nuclear and spot segmentations manually for each image of a dataset.

A CRITICAL: Discard cells containing two spots (e.g., S-phase cells that have already dupli-
cated the fluorescently tagged locus, Figure 2B) as this will bias the measure.

Optional: For the purpose of comparing absolutes distance values and zoning assay results, it
is necessary to define the nucleus center. Install the XT_MJG_SurfacePositionFinal compiled
Matlab routine and run the XTCenterOfMassToSpots XTension on the selected nucleus
surface (all extensions may be found either upon request or on the Imaris open permanent
XTension repository, https://imaris.oxinst.com/open/). This will create a spot corresponding
to the center of mass of the nucleus. This is a manual step, each image of a given dataset
has to be opened and no fully automated emulation of the zoning assay is proposed. The nu-
cleus’ center of mass is an approximation of the geometrical center as the Pus1-mCherry
signal is homogeneously distributed throughout the nucleoplasm. See troubleshooting 4.
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Alternatives: The Imaris XT module gives access to the use of Matlab compiled algorithm
run using Matlab Runtime Environment. You can adjust parameters on 2-3 images and
then apply this batch to all of these images. Install the XTBatchProcess Matlab XTension
(https://github.com/ppouchin/ImarisXT/blob/master/XTBatchProcess.m) together with the
XTDistanceTransformInsideObjectForBatch (Matlab and Imaris should be on the same work-
station). Refer to the Batch Process readme.txt file to use this batch version of distance
transformation.

56. Measure the absolute distance between the Lacl spot and the nuclear rim:

a. Download the distanceTransform.exe compiled Matlab XTension.

b. Select the nuclei surface and run the distance Transformation XTension (use the inside mode
to compute the distance to the envelope of the nuclear voxels). The software creates a new
channel (e.g., Channel 3) which corresponds to the distance between any locus and the nu-
clear periphery.

A CRITICAL: 32bits 3D-SIM images are directly compatible with fine distance measurements
(as intensities are floating-point numbers). If using other bit depth dataset, convert them to
32 bits prior to distance calculation (otherwise distances will be expressed as integer and
prevent fine distance measurement).

Optional: For the purpose of emulating the zoning assay, measure the absolute distance be-
tween the Lacl spot and the nucleus center by selecting the center of the nucleus and using
compiled distanceTransformation routine. The software creates a new channel (e.g., channel
4) which correspond to the distance between the locus and the nucleus center. If using
XTBatchProcess Xtension, move the nucleus center spot first in the object list, then run the
XTBatchProcess and the XTDistanceTransformOutsideObjectForBatch so that this optional
step is automated.

57. Imaris offers the possibility to quickly compile all nuclei/spot values using the Vantage module.
Create a new Vantage 1D Plot from the Arena using intensity Center Channel 3/nuclear periph-
ery and another one using intensity center Channel 4/nucleus center or export the distances
values in a spreadsheet.

EXPECTED OUTCOMES

In Figure 3A, we provide an example of scoring a DNA locus position (GALT-GAL10 gene) using the
manual counting method (zoning).

The GAL1-GAL10 genes change of nuclear localization in response to the available carbon source.
Using manual scoring, we observe that GAL genes preferentially localize in the interior of the nucleus
(67%, Zone 3) under transcriptional repression (12h Glucose). During non-repressive condition (12h
Raffinose), GAL genes shift to the nuclear periphery in 50% of the cells (50%, Zone 1), although the
locus is not actively transcribed. Upon transcriptional activation (90 min Galactose), the frequency of
GAL genes positioned to the nuclear periphery further increases to reach 60%-80% of the cells (64%,
Zone 1). Relocation of this model locus has been reported by various laboratories with different tech-
niques (Cabal et al., 2006; Schmid et al., 2006). See troubleshooting 5. During galactose transcrip-
tional induction, several regions of chromosome 2 also shift from an internal to a peripheral locali-
zation (Dultz et al., 2016). This is also the case for loci located on other chromosomes, such as
HXK1 (Taddei et al., 2006).

In Figure 3B, we provide an example of scoring a DNA locus position (replication origin ARS607) us-
ing the automatic determination of a DNA locus absolute distance from the nuclear periphery.
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Figure 3. Measurements of DNA loci 3D position in the nucleus

(A) Distribution of the GALT-GAL10 locus in wild-type cells grown either in repressive (12h glucose), non-repressive
(12h Raffinose) or active (90 min Galactose) conditions using the zoning assay (Forey et al., 2020). The dashed line
indicates a random distribution, or 33% in each zone. At least 200 cells were imaged/condition. SEM is indicated. * p
value <1073, by two-sided Fischer's exact t test.

(B) Absolute distance between the ARS607 locus and the nuclear periphery in S phase or in S phase + DNA damage
(HU +MMS), measured from 3D-SIM images using the Imaris software. Data are expressed as whiskers plot. Box, 25-75
percentile range. Whiskers, 10-90 percentiles range. Median is indicated in um.

(C) Model of a segmented nucleus. The nucleoplasm is in red, the fluorescent DNA locus is in green, the mass center of the
nucleus in black. Absolute distances between the fluorescent DNA locus and the nuclear periphery (d1) or with the nucleus
center (d2) are indicated. To apply the zoning assay, we determined the required nucleus diameter (i.e (d1+d2)x2).

(D) Absolute distances are used to apply the zoning assay. The dashed line indicates a random distribution, or 33% in
each zone. The number of cells is indicated for each condition. SEM is indicated. * p value <1073, by two-sided
Fischer's exact t test.

Using automatic determination of distance, we found that ARS607 is localized at a median distance
of 0.33 um from the nuclear periphery in asynchronous cells (Figure 3B). Treating cells with genotoxic
agents (hydroxyurea and methyl methanesulfonate) for 1h leads to the relocation of damaged repli-
cation forks toward the nuclear periphery (median distance of 0.16um, Figure 3B). The relocation of
collapsed replication forks to nuclear pores has been described by the Gasser laboratory using
manual scoring of the spot-pore distance (zoning) (Nagai et al., 2008). Using the data obtained
with our automatic method to determine distances (Figure 3C), we applied the zoning assay and
determined ARS607 position in the 3 nuclear zones (Figure 3D). Treatment with genotoxic agents
(HU and MMS) induced a shift of the ARS607 locus toward the nuclear periphery (52% vs 77% of cells
when comparing untreated cells versus HU + MMS treated cells, Figure 3D).

QUANTIFICATION AND STATISTICAL ANALYSIS

Analysis of a DNA locus is generally performed on 200-300 individual cells. We advise to measure a
DNA locus position in cells obtained from at least two independent cultures to minimize single-cul-
ture effects. Determined positions from independent cultures can be pooled to obtain the zone dis-
tribution. A 33% distribution in each zone indicate a random nuclear distribution for a given locus.
Preferential localization in either zone is characterized by an increased frequency of cells exhibiting
an enrichment of the tagged DNA locus in a given zone.
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To compare a given DNA locus position in two different contexts (culture medium, cell cycle phase,
strain background,...), the statistical significance of differences in locus location at each zone is
determined using a Chi-square test. Alternatively, one can also compare percentages of loci scored
in a single zone (e.g., peripheral zone 1) using statistical tests comparing means or medians of inde-
pendent samples (e.g., Mann-Whitney’s test) or compare variances between independent samples
(e.g., Fischer's test). These tests can also be used to compare the values of DNA locus-nuclear pe-
riphery distance obtained by automatic measurements.

It is worth noting that in asynchronous or S phase samples, the tagged locus can be present in two
copies in a number of cells and will thus appear as two nuclear foci. Cells exhibiting a duplicated
tagged locus are discarded from the manual and automatic analyses.

LIMITATIONS

Manual scoring by the zoning technique requiresdiscarding fluorescent DNA loci that are located in
the 20% top and bottom of the nucleus due to the inability to discriminate between internal and pe-
ripheral localization. This introduce bias when trying to determine the absolute position of a DNA
locus in a given condition, but is not a problem when comparing the relative location of the same
DNA locus between different contexts. Another limitation of the zoning technique is inherent to
the fact that this method assimilates the yeast nucleus to a spheroid when scoring the localization
of the tagged DNA locus in either zone. While in wild-type cells, most of the nuclei can accurately
be represented by an ellipsoid, some mutations and/or conditions alter nuclear morphology.
Thus, scoring a DNA locus position in cells with high frequency of altered nuclei is of low accuracy.

Measuring absolute distances separating the fluorescent DNA locus from the nuclear periphery in a
3D reconstructed nucleus is not submitted to these biases since this is a direct measure of the 3D
distance between the nuclear envelope and the tagged DNA locus. Yet, one limitation of this tech-
nique is that it requires the 3D reconstruction of a continuous and homogeneous signal for the nu-
clear envelope. We noticed that fluorescently tagged proteins that are embedded punctually into
the nuclear envelope (such as nucleoporins) do not allow an easy 3D reconstruction of the nuclear
envelope outlines using Imaris, as staining is quite discrete and even more discrete using 3D-SIM.
The best 3D reconstruction result with Imaris was obtained using the fluorescently tagged nuclear
marker Pus1-mCherry which display a homogenous staining of the whole nuclear volume (Han
et al., 2008). Thus, we advise to use this staining to define the nuclear envelope as the outer limit
of the nucleoplasm.

One major limitation to produce accurate measurements in the 3D nucleus is the lack of resolution of
widefield microscopy. Mostimportantly, the lack of resolution in the axial direction introduces a non-
negligible systematic error in our measurements. To improve the accuracy and reliability of our mea-
surements we have opted to use 3D-SIM as an alternative to wide-field imaging. This technique of-
fers an 8-fold volumetric improvement (2 fold in each direction) of the resolution when compared to a
traditional widefield imaging equipment. While this resolution improvement may seem limited when
compared to other super-resolution techniques, 3D-SIM offers major advantages for our applica-
tions. First, the acquisition speed is fast, allowing the collection of numerous images that are
required to produce statistically meaningful data. Second, the light doses used in 3D-SIM are low
when compared with STED or SML (Single Molecule Localization) microscopy, thus preserving sam-
ples and facilitating the implementation of this technique in our experimental setup. Lastly, the res-
olution improvement offered by 3D-SIM is isotropic, i.e a doubling in each axis. It would be inter-
esting to investigate to which point a 3D-STED implementation could produce images with a fully
isotropic resolution.

In this protocol, we propose two complementary approaches. The first one uses 3D widefield
restored images and a manual scoring of a locus position in the nucleus whereas the second uses
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high resolution 3D-SIM images and an automated identification of a locus position in the nucleus
coupled to the measure of the distance between a locus and the nuclear periphery. The best results
were obtained when different channels were used to track the locus and the nuclear rim (e.g., a GFP-
tagged locus and a mCherry nuclear staining). In this configuration, chromatic aberrations occur. In
the widefield procedure, any chromatic shift is kept below resolution whereas in the SIM protocol,
shifts (as measured with control multifluorescent beads) are used for 3D reconstruction. Using the
first approach and a widefield setup to assign a locus in three different zones is compatible with
the system'’s resolution and the handling of chromatic aberrations. Although automated loci identi-
fication and positioning with respect to the nucleus are theoretically applicable to widefield images,
we believe the system’s resolution and chromatic aberrations will introduce a too great variability to
yield accurate and reproducible results. On the other hand, 3D-SIM images are perfectly compatible
with the first manual approach to score a locus position in the nucleus by zoning assay.

TROUBLESHOOTING

Problem 1

GAL1-10locus is not repositioning strongly to the nuclear periphery after shifting cells to galactose
medium (see steps 1-3).

Potential solution

Although GAL genes induction is readily determined at the RNA level, peripheral relocation to nu-
clear pores is optimum when cells are growing exponentially at a low density (3-4.10° cells/mL).
Dilute your culture to 0.5-1.10° cells/mL and let cells grow until a 3-4.10° cells/mL concentration
is reached before adding the galactose to the medium.

Problem 2
Fluorescence signal is globally uneven or faint (see steps 6-9).

Potential solution

Consider using high quality (e.g., Alfa Aesar or EMS manufacturers) and freshly opened or prepared
PFA. Fixation should not exceed 1 min including centrifugation. Fix again new cells as describe in
“Fixing cells with paraformaldehyde”.

Problem 3
Too many or not enough cells in field of view (see step 25).

Potential solution

Cell adhesion is not homogenous on the coverslip and a different field of view might be more suit-
able for image acquisition. Alternatively, adjust PBS resuspension volume according to cell pellet
size at the end of the fixation step and prepare a new coverslip for imaging.

Problem 4
The center of mass of the nucleus does not correspond to the geometrical center (see step 55).

Potential solution

Although nuclei segmentation can be performed with various nucleoplasmic staining conditions using a
heterogeneously distributed nucleoplasmic marker (e.g., DAPI) may yield a biased estimation of the nu-
cleus mass center. We advise to use the fluorescent Pus1 nucleoplasmic marker, which exhibit a homog-
enous distribution in the whole nucleus, thus mass center and geometrical are confounded.

Problem 5

| do not observe the same percentage of cells exhibiting a peripheral location of the GAL1-10locus
when comparing cells grown in non-inducing versus repressing sugar (i.e raffinose vs glucose) (See
expected outcomes and Figure 3A).
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Potential solution

Although GAL genes are not transcribed when cells are grown in either sugar (raffinose or glucose),
cells grown in raffinose overnight will exhibit a robust non-random location of the GALT-10 (i.e 40%—
50% at the nuclear periphery) whereas cells grown in glucose overnight will typically exhibit less than
33% of GAL1-10 locus to the nuclear periphery. Upon galactose addition, the percentage of cells
exhibiting a GALT-10 locus to the nuclear periphery will reach 60%-80% (Figure 3A).

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-
filled by the lead contact, Jéréme Poli (jerome.poli@igh.cnrs.fr).

Materials availability

All unique strains generated in this study are available from the lead contact without restriction. Re-
quests for strains donated by other laboratories should be directed to the specific laboratory from
which they were received. This study did not generate new unique reagents.

Data and code availability
This study did not generate any unique dataset or code.
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